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RESUMEN

Uno de los retos a los que se enfrentan los profesionales 
sanitarios es la gestión y organización de la literatura cien-
tífica a la que acceden en el desarrollo de sus actividades 
asistenciales, docentes e investigadoras. Los gestores de 
referencias bibliográficas son programas informáticos que 
ayudan al usuario a almacenar y organizar documentos y 
referencias bibliográficas, y que también facilitan las tareas 
de citación y elaboración de la bibliografía al redactar una 
publicación académica. 

Se repasa la evolución de los gestores de referencias en 
las últimas décadas hasta la aparición de nuevos programas 
disponibles de forma gratuita, ya sea en forma de programas 
de escritorio como de servicios web. Se revisan las caracte-
rísticas básicas de los tres gestores de referencias gratuitos 
más completos en el momento actual: Mendeley, Zotero y 
Colwiz. Como ejemplo, se describe con más detalle el fun-
cionamiento de Mendeley.

Los nuevos gestores de referencias bibliográficas gratui-
tos pueden cubrir las necesidades de la mayoría de profe-
sionales sanitarios en la gestión integral de sus colecciones 
de documentos y referencias.

Palabras clave: Almacenamiento y recuperación de la 
información; Informática médica; Software; Bases de datos 
bibliográficas; Internet.

ABSTRACT

Managing and classifying biomedical literature that 
health professionals store during healthcare, teaching, and 
research purposes is a huge challenge for them. Reference 
managers are software that helps scholars to store and organ-
ize documents and bibliographic references. They also make 
easier to manage bibliographic citations and creating bibli-
ography when writing a scholarly manuscript.

Reference managers evolution over the last decades, 
until the emergence of new software tools available free 
of charge either as desktop programs or as web services, 
is revised. Basic features of the three more complete free 
reference managers currently available –Mendeley, Zotero, 
and colwiz– are reviewed. As an example, use of Mendeley 
is described with more detail.

New free reference managers are able to meet the needs 
of most health care professionals for comprehensive manage-
ment of their documents and references collections. 

Key words: Information storage and retrieval; Medical 
informatics; Software; Database, Bibliographic; Internet.

Introducción

Tanto en la formación clínica como en la labor docente o 
investigadora, uno de los retos a los que se enfrenta el profe-
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sional sanitario es la gestión y organización de la literatura 
científica que pasa por delante de sus ojos. A lo largo de las 
décadas, la forma de hacerlo ha ido evolucionando de forma 
paralela a la transición que las publicaciones biomédicas 
han experimentado desde el papel al soporte digital. Los 
armarios y estanterías ocupados con volúmenes impresos, 
los artículos fotocopiados apilados o agrupados en carpetas, 
o las fichas bibliográficas almacenadas en archivadores han 
ido sustituyéndose por discos duros repletos de documentos 
digitales en formato PDF. Por desgracia, más allá del ahorro 
en papel y espacio físico, los archivos digitales pueden ser 
aún más difíciles de gestionar sin una adecuada organiza-
ción y sin herramientas que permitan localizarlos cuando 
vuelven a ser necesarios(1).

Con el desarrollo de la informática y la generalización 
de los formatos digitales, la forma típica de organizar las 
colecciones de literatura académica ha sido el almacena-
miento de artículos completos en formato PDF unido al 
empleo de algún software de gestión de referencias biblio-
gráficas(2). 

¿Qué es un gestor de referencias 
bibliográficas?

Los gestores de referencias bibliográficas son programas 
informáticos que ayudan al usuario a crear su propia base de 
datos personal, almacenando y recopilando las referencias 
bibliográficas, y que también facilitan las tareas de citación 
y elaboración de la bibliografía al redactar una publicación 
académica(3,4).

Estos programas incorporan habitualmente las siguientes 
funciones:
–	 Introducción de nuevos registros: puede hacerse de for-

ma manual o –con más frecuencia– de manera automáti-
ca desde una base de datos en línea, la página web de la 
publicación original o el propio documento en formato 
PDF.

–	 Importación y exportación: que permite trasladar refe-
rencias o colecciones personales desde o hacia otros ges-
tores de referencias o bases de datos bibliográficas.

–	 Clasificación: mediante la creación de carpetas o el uso 
de palabras clave para ordenar las referencias en distintas 
colecciones, algo fundamental a medida que la base de 
datos crece.

–	 Detección y fusión de referencias duplicadas.
–	 Anotación: para incorporar comentarios propios a una 

referencia. Algunos programas son capaces de incluir 
las anotaciones dentro de los propios documentos PDF.

–	 Búsqueda: facilita encontrar determinadas referencias 
dentro de la base de datos personal o de una colección 
concreta, ya sea mediante una búsqueda sencilla o en 
campos determinados.

–	 Generación automática de citas y del listado de refe-
rencias bibliográficas desde un procesador de textos: 
añadiendo las referencias a medida que se escribe el 
documento y dando formato tanto a la notación de las 
citas dentro del texto como al listado final de referencias. 
Eso permite modificar el estilo de citación en función del 
medio en el que se piensa publicar el trabajo. 

Evolución de los gestores de referencias bibliográficas
Los primeros gestores en aparecer en escena, en la década 

de los 80, fueron aplicaciones de escritorio, instalables en un 
ordenador personal y con la base de datos residiendo en su 
disco duro. La conexión a internet solo se emplea para reali-
zar búsquedas en bases de datos desde el propio programa. 
Los gestores de escritorio más relevantes han sido ProCite 
(abandonado en 2013), Reference Manager (todavía el único 
de este tipo con posibilidad de trabajar simultáneamente 
con múltiples usuarios, pero que no recibe actualizaciones 
desde 2010) y EndNote. Todos ellos son propiedad de la 
empresa Thomson Reuters, pero solo EndNote mantiene 
un desarrollo activo en el momento actual.

Con los programas de escritorio, la gestión de referencias 
suele describirse como un flujo de trabajo triangular, que 
comienza con una búsqueda en una base de datos biblio-
gráfica en línea (p.ej. MEDLINE), continúa en el gestor de 
referencias y desemboca en un procesador de textos, para 
volver a iniciar el ciclo con una nueva búsqueda(5).

En los últimos años han aparecido nuevos gestores 
de referencias basados en la web, aunque algunos de 
ellos funcionan también como programas de escritorio. 
De hecho, una de las mejores virtudes de servicios como 
Mendeley (www.mendeley.com), Zotero (www.zotero.org) 
o Papers (www.papersapp.com) es la capacidad de ges-
tionar bibliotecas de documentos PDF. Algunos de estos 
programas (Fig. 1) abordan la gestión de documentos de 
manera análoga a servicios de música en línea como iTu-
nes, desarrollado por la empresa Apple Inc. a raíz del éxito 
de sus reproductores multimedia iPod. Esto ha facilitado 
su popularidad entre las nuevas generaciones de inves-
tigadores(5). Son capaces de explorar un disco duro para 
localizar publicaciones en formato digital y extraer sus 
metadatos, permiten organizar la biblioteca a gusto del 
usuario –mediante carpetas, palabras clave, listas, etc.– y 
la hacen accesible desde cualquier ordenador o dispositivo 
móvil conectado a internet.
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Los nuevos gestores de referencias han sabido también 
aprovechar las capacidades de la web 2.0(6,7) para facilitar el 
trabajo colaborativo y formar redes sociales profesionales(1). 
Existen servicios que ni siquiera disponen de programas de 
escritorio, sino que funcionan únicamente desde un navega-
dor web, como CiteULike (www.citeulike.org) o BibSonomy 
(www.bibsonomy.org).

Elegir un gestor de referencias

La oferta actual disponible de gestores de referencias 
bibliográficas es realmente abundante. Wikipedia recoge más 
de 30 en una entrada donde compara sus características(8), 
lo cual puede resultar abrumador como primera toma de 
contacto.

EndNote puede ser considerado como el gestor de refe-
rencia por tradición. Aunque dispone de una versión web 
gratuita –Endnote Basic–, la versión completa resulta cara 

(114 $ en su versión para estudiantes) sin que ofrezca venta-
jas claras sobre alternativas más baratas o gratuitas(9). 

RefWorks es una herramienta en línea popular en las 
universidades españolas, al contar muchas de ellas con sus-
cripciones institucionales que permiten su uso a personal 
y estudiantes universitarios(10). Carece de funciones como 
gestor de documentos PDF de escritorio, aunque sí dispone 
de un complemento instalable para conectarse con el proce-
sador de textos Microsoft Word. Tiene el inconveniente de 
que, una vez que finaliza la vinculación con la institución 
que proporciona el acceso, una suscripción individual cuesta 
100 $ al año.

Afortunadamente, existen gestores gratuitos muy com-
pletos que resultan buenas opciones para iniciarse en estas 
herramientas. Una buena idea es probar varios para elegir 
aquel que resulte más cómodo e intuitivo para el usuario. 
Para este artículo se han seleccionado tres gestores de refe-
rencias bibliográficas que incluyen todas las prestaciones 
que se exigen a estos programas: gestión de biblioteca de 

Figura 1. Ventana de Mendeley Desktop, el programa de escritorio de Mendeley. Su diseño se asemeja al de gestores de bibliotecas de 
colecciones musicales como iTunes. Las referencias se pueden organizar en carpetas y ordenarse por autor, título, publicación de origen 
o fecha.
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archivos PDF, gestión de referencias, copia de seguridad y 
acceso desde la web, multiplataforma, integración con pro-
cesadores de textos, aplicaciones para dispositivos móviles 
y funciones sociales. Los tres se pueden utilizar al completo 
de forma gratuita, aunque disponen opciones de pago para 
prestaciones adicionales.

Mendeley
Este gestor de referencias, desarrollado en 2008 por 

Mendeley Ltd., fue adquirido en 2013 por Elsevier. Cuenta 
con una comunidad de más de 2 millones de usuarios. Su 
gestor de escritorio (Fig. 1) está disponible para sistemas 
Windows, Mac OS y Linux. También dispone de aplicación 
para dispositivos móviles iOS (Fig. 2) y existen aplicacio-
nes de terceras partes para Android, como Scholarley. Una 
cuenta gratuita proporciona 2 GB de espacio para almacenar 
la biblioteca personal y 100 MB para documentos compar-
tidos, pero solo permite crear un grupo de trabajo privado 
para un máximo de 3 colaboradores. Se pueden contratar 
planes de pago para ampliar el espacio de almacenamiento 
o las posibilidades de colaboración, y también dispone de 
suscripciones institucionales. Una limitación es que no está 
disponible en castellano.

Uno de los puntos fuertes del software de escritorio de 
Mendeley es la gestión de documentos PDF, no solo por sus 
capacidades de reconocimiento, clasificación o búsqueda, 
sino por permitir insertar anotaciones en el propio documen-
to. Es capaz también de insertar citas y generar la bibliografía 
en un manuscrito mediante un complemento disponible para 
Word y para LibreOffice(11).

Destaca también por sus posibilidades colaborativas y 
como red social. Los grupos privados permiten compartir 
referencias y documentos, con algunas limitaciones en su 
versión gratuita. Los grupos públicos facilitan la formación 
de redes con investigadores en cualquier parte del mundo(12). 
Es posible seguir a otros usuarios para conocer sus nuevas 
publicaciones o su actividad en Mendeley. La web funciona 
como un repositorio de referencias, con posibilidad de cono-
cer estadísticas sobre artículos más populares.

Zotero
Se trata de un gestor de referencias gratuito y de código 

abierto, desarrollado desde 2006 por el Center for History and 
New Media de la Universidad George Mason (EE.UU.). Dise-
ñado inicialmente como complemento al navegador Fire-
fox(13,14) (Fig. 3), actualmente está disponible también como 
programa independiente para sistemas Windows, Mac OS y 
Linux. Está traducido al castellano. No tiene aplicaciones ofi-
ciales para dispositivos móviles, pero existen algunas inde-

pendientes para Android e iOS. Las cuentas gratuitas ofrecen 
300 MB de almacenamiento para documentos personales o 
compartidos en grupos, sin límites en la creación de grupos 
(públicos o privados) ni en el número de usuarios. Ofrece 
planes de pago para ampliar el espacio de almacenamiento.

Sus prestaciones son muy similares a Mendeley, inclu-
yendo la integración con procesadores de textos. Su pro-
grama de escritorio resulta algo menos potente, sin poder 
realizar directamente anotaciones en los documentos PDF. 
A cambio, su integración con los navegadores web –no solo 
con Firefox, pues dispone de complementos también para 
Chrome, Safari y Opera– está más conseguida, pues es capaz 
de avisar con un icono cuando una página web incluye una 
referencia bibliográfica y las guarda con mucha rapidez. Los 
usuarios de cuentas gratuitas tienen más capacidad de utili-
zar grupos colaborativos, aunque con menor capacidad de 

Figura 2. Aplicación de Mendeley para dispositivos móviles iOS. 
Vista de referencias de una carpeta ordenadas por título. Los iconos 
con la flecha hacia abajo indican las referencias que pueden ser 
descargadas en formato PDF en el propio dispositivo.
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almacenamiento de documentos respecto a Mendeley. Su 
independencia de grandes grupos empresariales y la dis-
ponibilidad de su código fuente han facilitado su adopción 
por una gran comunidad de usuarios.

Colwiz
Es el más joven y menos conocido de los tres gestores de 

referencias bibliográficas, pues su primera versión estable se 
lanzó en 2013. Gestado inicialmente dentro de la Universi-
dad de Oxford, cuenta con el apoyo de grandes sociedades 
científicas y empresas(15). Al igual que Mendeley y Zotero, 
su gestor de escritorio se puede instalar en los principales 
sistemas operativos. Además, ofrece aplicaciones oficiales 
para dispositivos móviles iOS y Android. Ofrece de inicio 
2 GB de almacenamiento para referencias y todo tipo de 
archivos, con posibilidad de ampliarse hasta 30 GB invitan-
do a otros usuarios. No dispone de opciones de pago ni de 
versión en castellano.

Pese a su juventud, sus prestaciones se encuentran al 
nivel de sus competidores. Como gestor de referencias y 

documentos, PDF rivaliza con Mendeley, incluyendo el 
subrayado y anotación de documentos PDF, que puede 
hacerse y visualizarse tanto desde el programa de escritorio 
como desde el visor que integra en su propia página web 
(Fig. 4). Para el trabajo colaborativo, comparte con Zotero 
la ausencia de limitaciones para crear grupos y, además, 
incorpora herramientas como un calendario y un gestor de 
tareas. También es capaz de integrarse con los procesadores 
de textos más conocidos para insertar referencias y crear 
bibliografías. Como inconveniente hay que señalar que el 
programa de escritorio funciona con cierta lentitud en com-
paración con otras alternativas(9).

Cómo se utilizan: introducción a Mendeley

Tras haber comentado las principales características 
de tres buenos gestores de referencias bibliográficas, es el 
momento de revisar su funcionamiento con más detalle. Por 
cuestiones de espacio se ha optado por elegir uno de los 

Figura 3. Zotero funcionando como complemento del navegador web Firefox. En la parte inferior se despliega el gestor de referencias. 
En la barra de direcciones, un pequeño icono con forma de página con texto informa de que ha reconocido la página actual como un 
artículo que se puede guardar en la base de datos.
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dos más populares. Existen más publicaciones académicas y 
manuales disponibles en internet en castellano e inglés para 
Zotero(10,13,14), por lo que, para este artículo, se ha escogido 
Mendeley. No obstante, el manejo es bastante similar entre 
las tres opciones y, antes de decantarse por uno, es recomen-
dable probar distintas alternativas.

Registro e instalación de Mendeley
El primer paso es ir a su página web (www.mendeley.com) 

para crear una cuenta de usuario. Solo con eso ya es posible 
comenzar a utilizar Mendeley desde la web para añadir refe-
rencias, organizarlas o usar las funciones sociales. Si se quiere 
una gestión más avanzada de los documentos y poder usarlo 
sin conexión a internet, es necesario descargar también el pro-
grama de escritorio (Fig. 1). El instalador está disponible en 
su web (www.mendeley.com/download-mendeley-desktop) 
para los principales sistemas operativos. Tras descargar y eje-
cutar el instalador, Mendeley estará listo para ser ejecutado en 
el ordenador, siendo necesario introducir el correo electrónico 
y la contraseña con la que se ha hecho el registro en su página 

web. Así, la base de datos de referencias del ordenador estará 
siempre sincronizada con la web de Mendeley.

Un último paso antes de comenzar es instalar en nues-
tro navegador web el botón que permite añadir referencias 
directamente desde internet. Solo hay que ir a la página www.
mendeley.com/import y arrastrar a la barra de marcadores o 
favoritos del navegador el botón “Save to Mendeley” (Fig. 5).

Importar una base de datos desde otro programa
Aquellos que hayan utilizado previamente otros gestores 

de referencias bibliográficas pueden utilizar sus bases de 
datos en Mendeley. El proceso consiste en exportar las refe-
rencias desde el programa original en alguno de los formatos 
compatibles (BibTeX, EndNote XML o RIS) y luego impor-
tar el archivo resultante desde el menú “File>Import” del 
programa de escritorio de Mendeley (no es posible hacerlo 
desde la versión web).

Del mismo modo, es posible exportar las referencias 
desde Mendeley a otros gestores, algo que facilita probar 
alternativas sin tener que comenzar desde cero.

Figura 4. Versión web del gestor de referencias Colwiz.
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Añadir referencias
La forma más sencilla de añadir una referencia es con 

el navegador desde la página web del artículo, mediante el 
botón “Save to Mendeley” (Fig. 5). El sistema es capaz de reco-
nocer los metadatos de publicaciones desde muchas bases 
de datos y grandes grupos editoriales internacionales. Si 
la publicación es de acceso abierto, al guardar la referencia 
ofrece la opción de descargarlo también en formato PDF. 
En el caso de publicaciones que no sean reconocidas, suele 
funcionar localizar la referencia en una base de datos biblio-
gráfica (PubMed, Google Académico, etc.). Si la referencia no 
está disponible de esta manera, se puede añadir de manera 
manual tanto desde el programa de escritorio (“File>Add 
Entry Manually”) como desde la web (pestaña “My Library”, 
botón “Add Document”). El repertorio de documentos permi-
tidos es muy amplio, incluyendo artículos, libros, capítulos 
de libros, tesis, páginas web, etc.

También existe la opción de añadir directamente archi-
vos PDF a través del programa de escritorio, desde el menú 
“File>Add File” o arrastrando y soltando el archivo dentro 
de la ventana. Si se trata de una colección de documen-
tos, se puede añadir una carpeta (menú “File>Add Folder”) 
para que incluya todos los documentos contenidos en ella. 
Existe también la opción de seleccionar determinadas car-
petas del ordenador para que Mendeley las vigile e importe 

automáticamente cualquier documento que se añada a ellas 
(Menú “File>Watch Folder”). En todos estos casos, el progra-
ma examinará los documentos PDF para extraer los datos 
bibliográficos, lo cual no siempre es posible. Las referencias 
dudosas serán clasificadas en la carpeta “Needs Review”, des-
de donde pueden ser revisadas para corregirlas o añadir los 
datos que falten.

Gestionar referencias
Mendeley permite crear carpetas en las que poder clasi-

ficar las referencias y documentos, siendo posible añadir la 
misma referencia a más de una carpeta. Existe una carpeta 
llamada “My Publications” reservada para los documentos en 
los que el usuario ha participado como autor; esto facilita la 
gestión del currículum de publicaciones. También se pueden 
añadir etiquetas a las referencias. La combinación de carpetas 
y etiquetas permite tener una biblioteca ordenada y fácil de 
filtrar, algo fundamental a medida que la biblioteca crece. 
Se puede marcar un documento como leído (círculo verde) 
y también como favorito (estrella amarilla).

No es raro que en una base de datos haya referencias 
repetidas. Mendeley es capaz de detectarlas automáticamen-
te desde el menú “Tools>Check for Duplicates”, ofreciendo 
un listado de posibles duplicados para su revisión y fusión 
si procede.

Figura 5. Utilización del 
botón para añadir referencias 
a Mendeley. Al presionar el 
botón “Save to Mendeley” en 
la barra de marcadores o 
favoritos del navegador, se 
despliega un recuadro que 
permite elegir en qué carpe-
ta guardarla, así como añadir 
etiquetas y notas.
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Una de las capacidades más interesantes del programa de 
escritorio de Mendeley es la de incluir anotaciones o subra-
yados en los documentos PDF (Fig. 6). Haciendo un doble 
clic sobre una referencia de la cual disponemos de un archivo 
PDF asociado se abre el visor de documentos. Este visor 
dispone de una barra de herramientas que incluye, entre 
otros, dos botones: el botón “Highlight” sirve para destacar 
un fragmento del texto al modo de un rotulador fluores-
cente, mientras que el botón “Note” inserta un comentario 
en un lugar concreto del documento, imitando el aspecto 
de un pósit.

Si se desea poder acceder a los documentos adjuntos de 
las referencias desde la web de Mendeley o desde disposi-
tivos móviles, es necesario activar la opción “Synchronize 
attached files”, a la que se accede desde el botón “Edit settings” 
encima de la lista de referencias. Esta opción se puede activar 
de manera selectiva para carpetas concretas de la colección, 
lo cual ayuda a no agotar el espacio de almacenamiento 
disponible.

Integración con procesadores de textos
Mendeley es capaz de integrarse con los procesadores 

de textos Microsoft Word y LibreOffice para añadir citas en 
un texto y generar un listado con las referencias bibliográ-
ficas. Antes hay que instalar el complemento o plugin des-

de el menú “Tools>Install MS Word Plugin” o “Tools>Install 
LibreOffice Plugin”, que añade una nueva barra de herramien-
tas al procesador correspondiente. En las últimas versiones 
de Word, la barra de herramientas se incorpora dentro de la 
pestaña “Referencias”; puede haber problemas para utilizar-
la si se ha deshabilitado la ejecución de macros.

Para añadir una cita en un documento hay que pulsar 
el botón “Insert Citation” de la barra de herramientas (Fig. 
7). Aparecerá una pequeña ventana desde la que podemos 
buscar la referencia que nos interesa y seleccionarla para ser 
insertada en el documento. Otra opción es pulsar el botón 
“Go to Mendeley” para ir al programa de escritorio, seleccio-
nar las referencias deseadas y pulsar el botón “Cite” dentro 
del programa. Desde la barra de herramientas del procesador 
de textos se puede elegir el estilo de cita deseado, lo cual 
incluye tanto la forma de incluir las citas en el texto (núme-
ros, autor-año, etc.) como el formato de la lista de referencias 
bibliográficas. Mendeley incluye gran cantidad de estilos de 
diversas publicaciones científicas y algunos genéricos como 
el estilo Vancouver. Es posible cambiar el estilo de las citas 
en cualquier momento. 

El paso final en un manuscrito es la inserción de la lis-
ta de referencias bibliográficas en el lugar del documento 
deseado mediante el botón “Insert Bibliography”. Aunque 
este sistema funciona razonablemente bien, es conveniente 

Figura 6. Visor de 
documentos del pro-
grama de escritorio 
de Mendeley. Dis-
pone de herramien-
tas para subrayar el 
texto e insertar ano-
taciones.
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revisar siempre el listado final de referencias antes de enviar 
un manuscrito para su publicación.

Grupos y funciones sociales
Más allá del uso personal para gestionar una biblioteca 

de referencias, merece la pena explorar las funciones cola-
borativas que convierten a Mendeley en una red social de 
investigadores. En este caso el protagonismo recae en la 
página web. Tras entrar en la cuenta personal, podemos 
ver en la parte superior de la web distintas pestañas. La 
primera de ellas, denominada Dashboard, representa el 
tablero en el que aparecerán las actualizaciones de la red 
del usuario, de manera análoga a como ocurre en redes 
sociales de uso general como Twitter. Inicialmente estará 
vacía, pero a medida que se establezcan contactos aquí se 
verá la actividad de otros usuarios en Mendeley. Al igual 
que en Twitter, podemos seguir a (follow) o ser seguidos por 
otros miembros de la red (followers), aunque cada usuario 
tiene que dar su autorización antes de poder ser seguido. 
La pestaña People es donde se pueden buscar usuarios para 
establecer contacto.

La pestaña Papers (Fig. 8) muestra toda la actividad de 
Mendeley, lo cual permite saber cuáles son las referencias 
más populares y más recientes de forma global y en las 
distintas disciplinas académicas. La editorial Elsevier ha 

aprovechado esta capacidad al integrar las estadísticas en 
su buscador Scopus. Esta pestaña también sirve como bus-
cador, puesto que Mendeley se comporta como una base de 
datos bibliográfica nutrida por la actividad de sus usuarios. 
Desde aquí se pueden guardar referencias directamente en 
nuestra colección.

Finalmente, la pestaña Groups es donde se gestiona la 
actividad relacionada con los grupos. Los grupos permiten 
reunir a personas interesadas en un tema concreto para com-
partir referencias o discutir sobre ellas. Pueden ser públicos 
(que a su vez pueden ser abiertos o requerir invitación) o 
privados. Los grupos privados permiten compartir no solo 
las referencias, sino también los documentos completos, pero 
las cuentas gratuitas solo permiten crear un grupo de este 
tipo con un máximo de tres miembros.

Conclusiones

En estos momentos hay una buena disponibilidad de 
gestores de referencias bibliográficas gratuitos que pueden 
cubrir las necesidades de la mayoría de profesionales sani-
tarios en la gestión de colecciones de documentos y refe-
rencias, investigación o elaboración de manuscritos para su 
publicación.

Figura 7. Uso del plugin de Mendeley para insertar una cita en un documento con el procesador de textos de LibreOffice.
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